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Method for the Collection, Gravimetric and Chemical Analysis of Nonvolatile Residue 

(NVR) on Surfaces 

Abstract 

Nonvolatile residue (NVR), sometimes referred to as molecular contamination is the term used for 

the total composition of the inorganic and high boiling point organic components in particulates 

and molecular films deposited on critical surfaces surrounding space structures, with the 

particulate and NVR contamination originating primarily from pre-launch operations. The 

“nonvolatile” suggestion from the terminology NVR implies that the collected residue will not 

experience much loss under ambient conditions. NVR has been shown to have a dramatic impact 

on the ability to perform optical measurements from platforms based in space. Such contaminants 

can be detected early by the controlled application of various detection techniques and 

contamination analyses. Contamination analyses are the techniques used to determine if materials, 

components, and subsystems can be expected to meet the performance requirements of a system. 

Of particular concern is the quantity of NVR contaminants that might be deposited on critical 

payload surfaces from these sources. Subsequent chemical analysis of the contaminant samples by 

infrared spectroscopy and gas chromatography mass spectrometry identifies the components, gives 

semi-quantitative estimates of contaminant thickness, indicates possible sources of the NVR, and 

provides guidance for effective cleanup procedures. In this report, a method for the collection and 

determination of the mass of NVR was generated by the authors at NASA Langley Research 

Center. This report describes the method developed and implemented for collecting NVR 

contaminants, and procedures for gravimetric and chemical analysis of the residue obtained. The 

result of this NVR analysis collaboration will help pave the way for Langley’s ability to certify 

flight hardware outgassing requirements in support of flight projects such as Stratospheric Aerosol 

and Gas Experiment III (SAGE III), Clouds and the Earth’s Radiant Energy System (CERES), 

Materials International Space Station Experiment – X (MISSE-X), and Doppler Aerosol Wind 

Lidar (DAWN). 

 

Introduction 

     Nonvolatile residue (NVR) resulting from the outgassing of materials used on spacecraft can 

cause electronic problems, serious attenuation of various optical signals, thermal control changes, 

and adhesion problems.1-4  Mission success is dependent on the effects of NVR on critical 

spacecraft hardware.  Failures in optical, thermal, and mechanical systems impact the life of a 

spacecraft and can result in the loss of millions of dollars.3,4 One approach to mitigate the risk 

from outgassed contamination, or NVR, is to choose  low outgassing materials.  The ASTM E595-

84 standard method of determining total mass loss (TML) and collected volatile condensable 

materials (CVCM) is widely used to screen and validate candidate materials.4,5 The 

commissioning of materials solely by this standard does not ensure compliance with spacecraft 

cleanliness and performance requirements. However, ASTM E595-84 testing has become 

standard practice for assessing NVR risk.  Nonetheless, good quality control to verify the space 

worthiness of materials before use in space systems is of extreme importance.  
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     An alternative method of contamination control for space applications is to test components 

and subsystems in thermal vacuum chambers which provide a space-like environment for 

collecting NVR on cryogenically cooled surfaces.6  The NVR is  collected on cold fingers and/or 

scavenger plates according to the method described in ASTM E834-81.7 A mass determination 

method is used  to quantitatively determine the amount of NVR and Fourier Transform Infrared 

(FTIR) spectroscopy and/or  Gas Chromatography Mass Spectrometry (GCMS) is used for 

chemical identification of  the  residue.1-3  Understanding the chemistry of material outgassing or 

NVR  helps to assist contamination control engineers  in making technically sound risk 

assessments. 

     In this regard, the method used for the nonvolatile residue analysis performed by the 

contamination control team is described in detail. Step-by-step procedures for a nonvolatile residue 

analysis process are provided in the main body of the document. Subsequent appendix sections 

include analytical instrumentation software procedures and instructions developed, adapted and 

followed for the respective NVR activity.  Adhering to these procedures without deviation enables 

the collection and determination of the mass and chemical composition of NVR samples. 

 

 

Description of Method 

Nonvolatile Residue NVR Collection and Detection  

    Nonvolatile residue collected in scavenger plates and cold fingers after the bake-out of a 

thermal vacuum chamber located in the Systems Integration & Test Branch SITB located at 

NASA Langley Research Center (NASA LARC) is extracted with 75 ml of isopropyl alcohol 

according to ASTM E834-81.7 The vast majority of NVR samples are collected from rinses off 

scavenger plates.  Scavenger plates and cold fingers are both composed of 316 stainless steel (See 

Figures 1 and 2).2,7 These scavenger plates are cryogenically controlled which enables the plate 

to collect particulate from outgassing events while performing integration testing. A cold finger 

is a device that is used in a thermal vacuum chamber for obtaining residual condensable gas and 

particulates during integration testing, and during testing operations, the cold finger is the last 

cryogenically controlled surface to return to ambient temerature.6 Both the scavenger plate and 

the cold finger operate as a cohesive system for monitoring the NVR deposition onto flight 

hardware. The comparison of NVR deposited on the scavenger plate and the cold finger enables 

the analyst to create a detailed investigation of the chemical composition and the amount of NVR 

deposited on space hardware.  
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Figure 1.  Scavenger Plate in Thermal Vacuum Chamber 

 

 

 

Figure 2.  Cold Finger in Thermal Vacuum Chamber 
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Gravimetric Analysis: Mass Determination 

     Mass determination allows for a gravimetric measurement of the molecular residue that 

accumulates on cold finger(s) and scavenger plate(s). The ability to determine this contamination 

gravimetrically allows for a quantification of the effect of NVR on critical spacecraft components.  

During the manual evaporation method, the mass of the molecular residue obtained from the NVR 

rinse is measured on the pre-weighed aluminum weighing pan.7,8  In addition to this, a blank 

control sample, using the same solvent, is collected from a witness plate of similar dimensions as 

the NVR rinse witness plate. The mass is recorded for the blank control sample, the aluminum pan 

plus residue, and the clean aluminum pan. The mass measurements obtained should be within +/- 

0.01mg for accurate and precise quantitative measurements. The calculations below are performed 

and a mass determination is obtained according to standards, ASTM E1235-12 and IEST-STD-

CC1246E.8-10 

 

NVR = (Mf – Mi) – Mb / V  

Mf = mass of the aluminum pan plus residue, mg 

Mi = mass of the aluminum pan, clean, mg 

Mb = mass of blank NVR, mg 

V = volumetric amount of NVR rinse sample added to aluminum pan, ml 

     This mass determination method requires the ability to work on a multi-dimensional surface 

since particles and molecular films can deposit on the front and backside of the witness plate.  The 

environmental conditions for the testing are in cryogenic and high vacuum surroundings. The 

method outlined in the aforementioned ASTM standards allow for a more accurate account of the 

mass collected on the witness plate by using gravimetric and volumetric data to obtain a 

quantitative account of the NVR.7,8  Both standards will account for the environmental and surface 

variations.  From the NVR calculation, the following table can be used to determine the NVR 

cleanliness levels.  Determining a mass and identifying the NVR cleanliness level will allow for a 

complete and selective quantitative measurement of the cold finger(s) and scavenger plate(s). 
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Table 1. Nonvolatile residue cleanliness levels (IEST- STD-CC1246E)10-12 

Chemical analysis 

     FTIR and GCMS (See Figure 3 and 4) are two powerful analytical techniques that can be used 

for examining the chemistry of material outgassing or  NVR. FTIR spectroscopy is a measurement 

technique that allows one to record infrared spectra. Fundamentally, FTIR spectra illustrate 

absorption bands with characteristic frequency attributed to different functional groups within the 

molecule, such as carbonyls (C=O), alkyls (C−H), or multiple-bonded carbon atoms (C=C) that 

vibrate at characteristic frequencies due to various bending or stretching motions. The frequencies 

are in the infrared range from approximately 1,000 to 3,500 cm-1 (10 to 2.9 μm) and can be shifted 

by intramolecular and non-bonded, intermolecular interactions.13,14  Infrared light is guided 

through an interferometer and then through the sample. The sample preparation procedure for 

NVR is relatively simple, straight forward and fast and is called “casting a film.”  This procedure 

involves dissolving the respective NVR in a small amount of solvent, transfer to a ZnSe (or the 

Attenuated Total Reflectance ATR crystal of choice), and evaporation of the solvent which leaves 

only the residual NVR film. FTIR has excellent sensitivity with the limit of detectability being 
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near 1 microgram. NVR typically consists of mixtures of compounds and FTIR analysis provides 

a readout of the chemical species present.  

 

 

 

Figure 3. Infrared Spectroscopy Laboratory (Building 1293C room 153C). 

 

 

Figure 4.  FTIR Spectrum of NVR from a Scavenger Plate. 
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     Infrared analysis is more powerful and beneficial when coupled with other types of analysis. 

For example, GCMS is an analytical tool that is often used in conjunction with infrared 

spectroscopy in the characterization and structural determination of samples (Figures 3, 4 and 5). 

A GCMS is simply a gas chromatograph with a very large and very expensive detector, but one 

that can give a definitive identification of mixtures of compounds (See Figures 5 and 6).15,16  

GCMS reveals the compounds eluted at different retention times with mass spectra corresponding 

to compounds present in a sample. The results of GCMS analysis are more revealing than FTIR 

and provides additional insights into the chemical nature of the NVR, including probable sources 

and possible consequences of the presence of these contaminants. Additionally, GCMS analysis 

may provide separation of complex mixtures, exact molecular identification of components, and 

profiles of the volatility characteristics of the NVR.1 The sensitivity of GCMS analysis is at least 

an order of magnitude better than FTIR.  Additional running of blank control samples and 

reference standards ensures the credibility and reliability of results.  

    

 

 

  Figure 5. GCMS Chromatograph Equipment Setup (Building 1293C room 266).  
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Figure 6. GC-MS chromatograph of NVR from a scavenger plate. 

 

Discussion of Nonvolatile Residue Collection and Analysis Procedure(s)  

      Nonvolatile residue collected in scavenger plates, Quartz Crystal Microbalance’s  QCM’s, and 

cold fingers after a bake-out from one of the thermal vacuum chambers located in the SITB at 

NASA LARC is extracted with 75 ml of isopropyl alcohol according to ASTM E834-81.5,6  The 

extracted samples are delivered to our laboratory located in the Advanced Materials and 

Processing Branch  (AMPB) where NVR measurements are performed to determine the amount 

(mass) and type of species outgassed from a sample during a bake-out test. The NVR was isolated 

and analyzed by the following methods and procedures (at AMPB): Mass Determination, FTIR, 

and GCMS. 

 

Scavenger Plate/Cold Finger Rinse Procedure 8-12  
 

Materials:  

 Pyrex Bottles  

 Isopropyl Alcohol (IPA)  

 Gloves  

 Safety Glasses  

 Anticon Gold® Wipes  
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 Kapton® Tape  

 Prepared Sample Labels  

 

 

General Instructions 

 

1. Obtain one 100 ml Pyrex storage containers (one for each cryogenic surface).  

2. Using the predesigned rinse labels found on the shared drive at the following location: 

Z:\NVR Analysis\CF_SP Rinse\IPA SAMPLE LABEL.  

3. Fill out a label completely and tape to the 100 ml Pyrex container using Kapton® tape (they 

are designed so that 2 inch Kapton® tape will cover them completely).  

4. Find a clean room approved bottle of Isopropyl alcohol.  

5. Follow proper gowning procedure for the cleanroom. 

6. Identify the cryogenic surface within the chamber and carefully rinse the full surface of the 

plate and catch tray with Isopropyl alcohol catching the runoff in the Pyrex container. The 

runoff will collect in the tray and will drain out the tube located at the bottom. Start rinse at 

the top of surface and move in horizontal passes. Make sure each pass overlaps the previous 

and make at least three full rinses of the surface.  

 

7. When there is about 40 ml of rinse in the Pyrex container, the rinse is complete.  

8. Place the top on the container and tighten down completely (make sure the cap is on tight 

so that the IPA does not evaporate).  

9. Using an Anticon Gold® wipe, clean off the cryogenic surface and catch tray (unless 

otherwise stated, this can be disposed of in the hazardous waste trash container).  

10. Check the travel tote for the following:  

a. Anticon Gold® wipes  

b. Bottle of IPA  

c. Gloves (Latex or Nitrile)  

d. Safety Glasses  

e. Capillaries  

f. Sample(s) that are to be tested  
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11. Bring the travel tote to the Infrared Spectroscopy Laboratory (Building 1293C in room 

153; location of FTIR Spectrometer) or the Solution Properties Laboratory (Chemistry 

laboratory and location of GCMS Spectrometer(s) in building 1293C).  

 

 

Sample Preparation, Mass Measurement, and Chemical Analysis  

 

The following items are required for NVR analysis:  

 Aluminum Weighing Pan(s) 

 100 mL Pyrex Beaker  

 Hot Plate 

 Bake-out Oven or Furnace (see Figure 7) 

 Capillary Tubes 

 Scale or Microbalance (see Figure 8) 

 Fume Hood 

 Desiccator 

 Isopropyl Alcohol, spectroscopic grade or better 

 Chloroform, spectroscopic-grade or better  

 FTIR (Thermoelectron Nexus 670 Spectrophotometer Fourier Transform Infrared 

Spectrophotometer)  

 Gas Chromatograph (Shimadzu GCMS-QP2010 Series Gas Chromatograph and Mass 

Spectrometer) 

 SafeSkin Corp. Hypoclean Powder Free Nitrile Gloves or equivalent brand  

 Furnace Gloves 

 Laboratory Coat 

 

Safety Precautions and Warnings 

 As with any handling of chemicals, do not inhale vapors produced. Chloroform is used in 

this experiment. These solvents are flammable. 

 Wear closed toe shoes in the laboratory. 

 Wear long pants in the laboratory. 

 Any shoulder length or longer hair should be secured. 
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General Instructions 

 

Aluminum Weighing Pan Preparation 

 

1. Clean aluminum pans with IPA. 

2. Bake-out the aluminum pans at 550°C for at least 1 hour to remove factory coating. 

 

Sample Preparation 

 

1. Rinse the sample from the surface (scavenger plate, cold finger, witness plate, etc.) with 

about 70 mL IPA. 

2. Collect the solvent into a clean glass container. Label and cover tightly to prevent 

contamination and evaporation during transport. 

 

 

Figure 7. Bake-out Furnace Setup (Building 1293C room 266). 

 

Procedure 

 

1. Take the final mass of aluminum pan to 3 significant figures.* 

2. Quantitatively pour collected solvent mixture into aluminum pan while recording the exact 

volume delivered to the aluminum pan. 

3. Heat solution using a hot plate on a low setting to avoid burning off any organics. 

4. Evaporate to approximately half of the initial volume, and remove the pan containing the 

mixture from the hot plate. 

5. Cover the mixture in pan with aluminum foil and leave under fume hood overnight. 

6. Take a second mass measurement in the morning.* 

7. Cover the bottom of the aluminum pan containing mixture with chloroform. 

8. Swirl mixture in pan to wet the bottom surfaces. 
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9. Tilt aluminum pan under fume hood, and let mixture evaporate until about 1 mL remains. 

10. Use a capillary tube to place a droplet of solution onto the ZnSe crystal on the FTIR 

spectrometer (Figure 9). 

11. Make solutions with NVR in chloroform in appropriate concentrations in GC ampoules. 

     *Take a record of the measurement. 

 

Figure 8.  Microbalance Setup (Building 1293C room 266).  

 

 

 

 

 

 

 

 

 

 

Figure 9. Adding the sample to the ZnSe crystal on the FTIR spectrometer.17 
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Flow Diagram (Instructions per day) 

Day 1 

1. Clean aluminum pans with IPA. 

2. Bake-out the aluminum pans at 550°C for at least 1 hour to remove factory coating. 

 

Day 2 

1. Rinse the sample from the surface (scavenger plate, cold finger, witness plate, etc.) with about 

70 mL of isopropyl alcohol (IPA). 

2. Collect the solvent into a clean glass container. Label and cover tightly to prevent contamination 

and evaporation during transport. 

 

Day 3 

1. Take the final mass of aluminum pan to 3 significant figures. 

2. Quantitatively pour collected solvent mixture into aluminum pan while recording the volume 

delivered to the aluminum pan. 

3. Heat solution using a hot plate on a low setting to avoid burning off any organics. 

4. Evaporate to approximately half of the initial volume, and remove the pan containing the 

mixture from the hot plate. 

5. Cover the mixture in the pan with aluminum foil and leave under fume hood overnight. 

 

Day 4 

1. Take a second mass measurement in the morning. 

2. Cover the bottom of the aluminum pan containing mixture with chloroform. 

3. Swirl mixture in pan to wet the bottom surfaces. 

4. Tilt aluminum pan under fume hood, and let mixture evaporate until about 1 mL remains. 
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Day 4 

1. Use a capillary tube to place a droplet of solution onto the ZnSe crystal. 

2. Perform FTIR measurement. 

Day 5 

1. Make solutions with NVR in chloroform in appropriate concentrations in GC ampoules. 

2. Perform Gas Chromatography Mass Spectroscopy (GCMS) measurements. 

3. Generate report. 

 

Example of Nonvolatile Residue Chemical Analysis Report 

 

ADVANCED MATERIALS & PROCESSING BRANCH 
BRANCH D307 

CHEMICAL ANALYSIS REPORT 
 

 

TO:  Systems Integration and Test Branch/D210 

 

FROM:  Advanced Materials & Processing Branch/D307/Dr. Keith Gordon 

 

SUBJECT: 6X6 Characterization Test 

     

DATE:  May 9, 2014 

 

ANALYSIS #: 02-6X6 

 

PROJECT: SAGE III-ISS 

 

Samples Submitted: 

Sample(s): Facility Scavenger Plate and Cold fingers and Post Test samples 

Item:  Chamber Background  

Facility:  6X6 TVAC 
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Analysis Performed: 

 [X] Mass Determination (NASA ECN 1815360) 

[X] Fourier Transform Infrared Spectroscopy {FTIR} (NASA ECN 2036845) 

[X] Gas Chromatography/Mass Spectrometry {GC/MS} (NASA ECN 1955352) 

 

Results: 

Facility Scavenger Plate 

 Total Amount of Residue:  1.65 + 0.06 mg 

Chemical Constituents (in order of abundance): 

1. Bis(2-ethylhexyl) nonanedioic acid (ester)- plasticizer 
2. Various hydrocarbons 
3. DC 704 pump fluid 
4. Tetratriacontane 
5. 1,2,3-trichloro-2-methylpropane 
6. 1,2,3,4-tetrachlorobutane 
7. DC-705 pump fluid 
8. 1,1-dichloro-2-ethynyl cyclopropane 
9. 2-ethylhexyl chloroformate 

 

Facility Scavenger Plate Post Test 

 Total Amount of Residue  0.73 + 0.06 mg 

Chemical Constituents (in order of abundance): 

1. Various hydrocarbons 
2. Bis(2-ethylhexyl) nonanedioic acid (ester) - plasticizer 
3. 1,2,3-trichloro-2-methylpropane 
4. 1,1-dichloro-2-ethynyl cyclopropane 
5. 1,2,3,4-tetrachlorobutane 
6. 2,3,-dichloro-2-methyl propanal 
7. 2,3-dimethyl-2-methylbutanol 
8. 1,3-dichloro-2-2-chloromethyl 
9. DC 704 pump fluid 
10. 1,1,1-tris(chloromethyl)ethane 
11. 1,1,2,3-tetrachloropropane 

 

Facility Cold finger  

 Total Amount of Residue: 0.03 + 0.06 mg 

Chemical Constituents (in order of abundance): 

1. 4-chloro-octane 
2. 1,2,3,4-tetrachlorobutane 
3. 1,2,3-trichloro-2-methylpropane 
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4. 2,3-dichloro-2-methylpropanal 
5. 2,3-dimethyl-2-butanol 
6. 1,2,3,4-tetrachloropropane 
7. (hexylsulfonyl)-benzene 
8. 1,1,3-trichloro-2-propanone 

 
Facility Cold finger  Post Test 

 Total Amount of Residue: 0.32 + 0.06 mg 

Chemical Constituents (in order of abundance): 

1. 1,2,3-trichloro-2-methylpropane 
2. 1,2,3,4-tetrachloro-butane 
3. 1,1-dichloro cyclopropane 
4. 2,3-dimethyl-2-butanol 
5. 2,3-dichloro-2-methylpropanal 
6. 1,3-dichloro 2-chloromethyl 
7. 1,8-dichloro 3,5-octadiene 
8. Chloroacetic acid propyl ester 
9. 5-methoxy-2-pentanone 

 

 

FTIR Results - Scavenger Plate 
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FTIR Results – Scavenger Plate Post Test 

 

FTIR Spectra –Facility Cold Finger 

 



 

 

 

18 

 

FTIR Spectra –Facility Cold Finger Post Test 

 

 

GC-MS Spectra – Scavenger Plate 
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GC-MS Spectra – Scavenger Plate Post Test  

 

 

 

GC-MS Spectra – Cold Finger  
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GC-MS Spectra – Cold Finger Post Test 

 

Comments: 

The residue collected by the facility scavenger plate primarily consisted of bis(2-ethylhexyl) 

nonanedioic acid (ester) and various hydrocarbons. The residue collected by the facility scavenger 

plate post-test consisted of various hydrocarbons and bis (2-ethylhexyl) nonanedioic acid (ester). 

The FTIR spectra for the scavenger plate and scavenger post-test are very similar, however an 

intense OH stretch (3300 cm-1) and –CH2 stretch (2900 cm-1) are present in the scavenger plate’s 

spectrum and is not present in the post-test’s spectrum. The OH stretch is attributed to the structure 

of the organic molecule, bis(2-ethylhexyl) nonanedioic acid (ester). The difference in spectra is 

attributed to the ester being present in greater quantity in the scavenger plate than in the scavenger 

plate post-test sample. Also, please note that GCMS indicated the presence of a small amount of 

pump fluid in both samples (2-3%).  

 

The residue collected by the facility cold finger primarily consisted of 4-chloro-octane and 

1,2,3,4-tetrachlorobutane (both are chlorinated hydrocarbons).  The residue collected by the 

facility cold finger post-test consisted 1,2,3-trichloro-2-methylpropane, 1,2,3,4-tetrachloro-

butane, 1,1-dichloro-cyclopropane and 2,3-dimethyl-2-butanol (all, except the last one, are 

chlorinated hydrocarbons). The FTIR spectra for the cold finger and the cold finger post-test are 

fairly similar. Two peaks at about 3700 cm-1 and 3200 cm-1 are present in the cold finger’s FTIR 

spectrum, but are absent in the cold finger post-test’s FTIR spectrum. Two peaks are most likely 

indicative of the presence of aldehyde and/or ketone molecules in the sample(s).  

 

Signed copy available upon request 

 

Keith Gordon 

cc: 

D210/Aranda,D.      D210/O’Connell, J.   

D210/Johnson, T.                 D210/Rice, C. 

D210/Thornblom,M.      D307/ Edahl, R.      

D307/ Bryant,R. 
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Summary 

     Nonvolatile residue on spacecraft surfaces can have severe effects on the successful operation 

of many advanced scientific experiments, therefore the detection and identification of such 

contaminants are essential.1 The molecular residue that accumulates on spacecraft components 

can be isolated via various detection NVR techniques and the total mass can be gravimetrically 

measured. Chemical analysis of NVR can be accomplished using FTIR, GCMS, or both. Thus, 

the resulting analysis identifies the components, gives semi-quantitative estimates of contaminant 

thickness, indicates possible sources of the NVR, and provides guidance for effective cleanup 

procedures. Additionally, the procedures for collection, determining the mass and chemical make-

up of NVR have been outlined and a step-by-step method for the nonvolatile residue analysis 

process is provided.  
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Procedure Overview 

 

PURPOSE: 

To provide step-by-step procedures that will allow for a Fourier Transform Infrared (FTIR) 

Spectroscopy analysis of nonvolatile residue (NVR) contaminants that are present in a cryogenic 

surface rinse collected after the completion of a thermal vacuum test.  

 

SCOPE: 

Fourier Transform Infrared Spectroscopy utilizes a Thermo Nicolet Nexus 670 Spectrometer found 

in the Advanced Materials & Processing Branch, building 1293C room 153 C. With the use of the 

Smart iRT accessory, the spectrometer is setup so that a quick analysis can be made of the rinse 

from a scavenger plate and/or cold finger. The OMNIC software has the capabilities of identifying 

compounds that have similar spectrum and identify which chemical functional groups are present 

in the sample based on the absorption peaks in the spectrum. 

 

PERSONNEL: 

One (1) qualified FTIR spectrometer operator. 

 

SUPPORT AND SAFETY SERVICES: 

Personnel working in the Downflow Cleanroom and in the thermal vacuum chamber will be 

required to wear approved cleanroom apparel in accordance with test hardware requirements. All 

personnel using the dedicated chemistry lab must have completed the required safety procedures 

and all safety standards must be followed. Contact the Facility Safety Head (FSH) for building 

1293C for training. 

  

 



 

25 

 

Working with chemicals: 

 Chemical Worker DVD 

 Hazard Communication 

 Annual Waste Management/Spill Response Training 

 Personal Protective Equipment PPE Awareness Training 

 Document review: 

o Building 1293A/C Chemical Hygiene Plan 

o Lab Specific chemical hygiene plan 

 Liquid nitrogen training 

Potentially Hazardous Materials PHM permit required:  

 Completed form 66 and annual physical 

INITIAL CONDITIONS: 

A test is completed in one of the vacuum chambers and the cold finger and/or scavenger plate was 

used.  
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Useful Images 

 

Figure A1: FTIR equipment setup (Building 1293C room 153C) 

 

 

Figure A2: Basic screen for OMNIC software 
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Scavenger Plate/Cold Finger Rinse Procedure 

 

Materials:  

 Pyrex Bottles 

 Isopropyl Alcohol (IPA) 

 Gloves 

 Safety Glasses 

 Anticon Gold® Wipes 

 Kapton® Tape 

 Prepared Sample Labels 

 

NOTE:  

This section of the procedure should be re-evaluated to remove the possibility of 

contaminating the cryogenic surface rinse! 

 

1. Obtain one 100 mL Pyrex storage containers (one for each cryogenic surface). 

2. Using the predesigned rinse labels found on the shared drive at the following location: Z:\NVR 

Analysis\CF_SP Rinse\IPA SAMPLE LABEL. 

3. Fill out a label completely and tape to the 100 mL Pyrex container using Kapton® tape (they 

are designed so that 2 in. Kapton® tape will cover them completely). 

4. Find a clean room approved bottle of IPA. 

5. Follow proper gowning procedure for the cleanroom. 

6. Identify the cryogenic surface within the chamber and carefully rinse the full surface of the 

plate and catch tray with IPA catching the runoff in the Pyrex container. The runoff will collect 

in the tray and will drain out the tube located at the bottom. Start rinse at the top of surface and 

move in horizontal passes. Make sure each pass overlaps the previous and make at least three 

full rinses of the surface. 

Note:  

The cold finger can be difficult to rinse. Make sure the full surface has been rinsed. It 

is acceptable to drip a small quantity of IPA within the chamber. Do not miss the top 

flat surface as well. 
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7. When there is about 40 ml of rinse in the Pyrex container, the rinse is complete. 

8. Place the top on the container and tighten down completely (make sure the cap is on tight so 

that the IPA does not evaporate). 

9. Using an Anticon Gold® wipe, clean off the cryogenic surface and catch tray (unless otherwise 

stated, this can be disposed of in the hazardous waste trash container). 

10. Check the FTIR travel tote for the following: 

a. Anticon Gold® wipes 

b. Bottle of IPA 

c. Gloves (Latex or Nitrile) 

d. Safety Glasses 

e. Capillaries 

f. Sample(s) that are to be tested 

11. Bring the travel tote to Infrared Spectroscopy Laboratory (Building 1293C room 153, location 

of FTIR Spectrometer) or chemistry lab (room 266 in building 1293C). 

 

Sample Preparation and Mass Measurement 

 

 

1. Clean Aluminum pans with IPA. 

2. Bake-out Aluminum pans at 550° C for at least 1 hour to remove coating. 

3. Take final Aluminum pan weight. 

4. Pour the whole rinse sample into aluminum pan and rinse the bottle with IPA and pour into 

aluminum pan. 

5. Heat solution using a hot plate (low setting to avoid burning off organics). 

 

NOTE: 

This section of the procedure should be re-evaluated so that the full mass of the NVR is 

found during the Mass Measurement! 
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6. Evaporate to approximately ½ volume, remove solution from hot plate. 

7. Tent with aluminum foil and leave solution under fume hood overnight. 

8. Weight the pan a second time once the IPA is evaporated. 

9. Re-dissolve solution with chloroform (enough to cover bottom of Al Pan). 

10. Swirl around and wet the bottom surfaces. 

11. Tilt aluminum pan and carefully carry it to the FTIR spectrometer. 

12. Wait until about 1 ml remains when the pan is tilted. 

 

Startup Procedure 

 

Materials:  

 Liquid Nitrogen (LN2) 

 Large dewar filled with LN2 

 Small dewar 

 Thermal gloves 

 Safety glasses 

 

NOTE: 

Contact Keith Gordon (phone: 757-864-2201) in the Advanced Materials & Processing 

Branch so that LN2 is made available.  Begin this process prior to adding chloroform to 

the NVR sample! 

 

NOTE: 

Only use pre-baked metal dish held in the controlled cabinet.  Before adding chloroform 

to the NVR sample move on to the “Startup Procedure”. 



 

33 

 

1. Log into the FTIR computer using the SITB user name and password: 

Username: Systems I&T Branch 

Password: XXXXX 

 

2. Take the large LN2 dewar and pour LN2 into the small dewar until full. If the Experiment 

Setup window is open and set to the “Diagnostic” tab, the reaction of the detector can be seen 

by the increased intensity of the interferogram, (Figure  A3): 

a. To open this window go to “Setting Up a Method” (page 63) in Appendix A.1 and 

follow steps 1 and 5. 

 

  

 

Figure A3.  (a) Interferogram in “Diagnostic” window before LN2 is added, (b) 

Interferogram in “Diagnostic” window during LN2 addition. 

(a) (b) 
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3. Open the cap located on the top left side and remove the stopper. This is the cap that is in the 

back, not the front cap that is labeled “DO NOT OPEN!” (Figure A4). 

 

Figure A4. LN2 fill cap. 

 

4. Use the shorter of the two funnels that are located on top of the microscope (Figure A5). 

Chill the metal tube in the LN2 that is in the smaller dewar and insert it into the fill hole. 

 

 

Figure A5. Two funnels on the microscope. 

Short Funnel  

LN2 Fill Cap  
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5. Carefully pour the LN2 into the funnel until full. Allow the LN2 to run into the spectrometer. 

Repeat until the LN2 has overflowed slightly into the well around the funnel.  

6. The spectrometer will be ready to be used in 30 minutes and can be used for 19 hours: 

a. If waiting longer than 30 minutes, more LN2 may need to be added. 

7. Remove funnel, replace stopper, and close cap down as much as possible (do not force 

closed. Depending on the amount of LN2 overflow it may not close at all). 

 

Preparing the Smart iTR 

 

Materials: 

 Capillaries 

 Latex or Nitrile gloves 

 IPA 

 Anticon Gold Wipes 

 

NOTE: 

This Procedure is primarily written as if  the Zinc Selenide (ZnSe) crystal is being used, it 

can also be used with the Diamond crystal assembly if the Experiment Method is changed 

to accommodate it. 

 

 

1. ZnSe crystal is stored in Solutions Properties Laboratory (room 266)  in the “NVR FTIR” 

drawer (Figure A6). You must also use the Smart iTR platform that is in the same drawer.  
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Figure A6: ZnSe Crystal (Solutions Properties Laboratory) 

 

 

2. With gloves on, remove the current Smart iTR from the spectrometer by lifting from the back 

and front (Figure A7). Carefully place it on the counter since it can be damaged easily. 
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Figure A7. Nexus 670 and continuum microscope 

 

3. Rotate the tip clear of the crystal and dark gray plate (Figure A8). 

 

 

Figure A8. Tip arm partially rotated out of the way. 

Smart iTR 

Front Lift 

Point 

Back Lift Point 
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4. Remove the dark gray plate and press the crystal assembly clear of its opening (Figure A9). 

The crystal needs to be pushed from the front to the back. Avoid touching the crystal. 

5. Remove the tip by unscrewing from arm: 

a. There are three different tips, check to see which is currently on the Smart iTR. 

b. Use the flat tip, it might be in the tip storage found under the gray plate (Figure 

A10). 

6. Clean the dark gray plate, tan surface where the dark gray plate sits and the ledge behind. 

Also, clean the tip with IPA and Anticon Gold® wipes. Be careful to not get any of the IPA 

on the mirrors located under the crystal. 

 

 

Figure A9. Dark gray plate, flat tip, and crystal assembly. 

 

Dark Gray Plate 

Crystal Assembly 

Flat Tip 
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Figure A10. Tan body of the Smart iTR with the dark gray plate removed. 

 

CAUTION! 

Do not apply IPA directly on the crystal. Get the Anticon Gold® wipes saturated with IPA 

and then wipe clean. 

 

7. Carefully clean the metal surfaces of the crystal and then the crystal itself. 

8. Replace the crystal assembly by fitting it into the plate going from the back to the front. It 

needs to sit parallel with the top of the surface. The rubber gasket should be seen completely 

above the surface (Figure A9). Take note about the location of the notches (Figures A12 and 

A13). They need to fit to the corresponding size peg on the body of the Smart iTR. 

 

NOTE: 

When pushing the crystal into the plate only touch the outer ring, see Figure A12. 

Surfaces to be cleaned 

Storage place for 

other tip styles 
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Figure A11. Crystal assembly fitted into dark gray plate. 

 

 

 

Figure A12. The bottom side of the crystal 

assembly. 

Figure A13. Recessed area for the 

diamond crystal assembly. 

Small Notch 

Small Peg 

Outer Ring 
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9. While supporting the crystal from the back, carefully place the dark gray plate back on the 

Smart iTR body while aligning the notches and pegs on the crystal. 

10. Replace the tip (the arm can either be left off to the side or moved back over the crystal). 

11. Place the Smart iTR into the spectrometer. 

 

Obtaining FTIR Analysis 

Materials:  

 Thumb Drive 

 

NOTE: 

When completed with analysis of all samples, log usage into log book at the computer. 

This requires date, your name, number of samples, and “Main” or “Microscope”. 

 

 

1. With the Smart iTR in place, the crystal cleaned, and having filled with LN2 30 minutes priors, 

open the software.  

2. Open the OMNIC software. When the program starts there will be a window indicating which 

accessory is currently installed. Verify that it is identifying the Smart iTR Accessory and hit 

“OK” (Figure A14). 
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Figure A14. Start-up screen with accessory verification. 

3. Check to see if the correct sample method is selected across the top of the screen (Figure A15, 

to setup a new method see Appendix  A.1). 

 

 

NOTE: 

If the accessory does not match the Experiment Method a warning will appear. This 

seems to be a normal occurrence. 
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Figure A15. The environment (method) selection bar. 

 

4. Swing the arm with the flat tip away from the crystal (Figure A8). 

5. Click on the “Col Smp” and take a background reading (Figure A16).  

 

 

Figure A16: Bar across OMNIC main screen. 

 

 

 

Col Smp to start the 

collection process 
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Figure A17. Typical background for the ZnSe crystal. 

 

6. A confirmation window will appear, hit “OK” (Figure A18). 
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Figure A18: Confirmation window for Background collection. 

 

7. Wait until the initial spectrum is displayed and then click on “Start Collection” in the top right 

corner (Figure A19). The system will adjust the spectrum based on the auto gain. This will 

happen until the sample is collected. 

 

Figure A19. Top right corner of OMNIC main window. 

 

Start Collection to begin collecting  
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8. A confirmation window will pop up asking if the user wants to take the sample reading, do not 

hit “OK” until the sample is in place (Figure A20). 

 

 

Figure A20: Confirmation window for reading sample. 

 

9. Take a capillary and collect a small amount of test solution, stop off the open end with a finger. 

10. Hold the capillary at an angle perpendicular to the crystal surface and allow one drop to settle 

on the crystal (Figure A21). 

11. Wait for the solvent to evaporate. 

 

For Evaluation of Solids Only!! 
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Swing the arm back over the crystal and turn the blue knob until the flat tip is resting on the 

crystal (Figure A22). 

 

 

Figure A21. Rotate the blue knob until the tip is touching the surface of the crystal. 

 

CAUTION! 

Do not over tighten! This will break the crystal. The tip just needs to come in contact 

with the crystal surface to remove any air pockets between the sample and the crystal. 
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Figure A22. Adding the sample to the crystal surface. 
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12. Click the “OK” button on the message screen on the computer and wait until the initial analysis 

appears. 

13. Click “Start Collection”  on the upper right hand side of the screen and wait for all the 

samples to be taken (Figure A19). 

14. A “Collect Sample” screen will appear and a time stamp will be filled in. Remove the 

“(GMT-##:##)” from the end and add the name of the spectrum, click “OK” (Figure A23). 

 

Figure A23. Collect Sample Window. 

 

15. Once all the samples have been taken, a confirmation window will appear. Answer “Yes” to 

the “Add to Window 1” question. (Figure A24).The unprocessed spectrum will appear in the 

main window (Figure A25). 

 

Figure A24: Confirmation window to add the spectrum to the main window. 
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Figure A25. The unprocessed spectrum for IPA using the Diamond Crystal. 
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Processing and Analyzing the Collected Sample 

 

 

1. If the grid is not being displayed it, can be found under View → Display Grid (Figure A26). 

 

Figure A26. “View” tab options. 

 

2. Check the box for “Show Grid” when the window opens (Figure A27). 

 

Figure A27. “Display Setup” Window. 
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3. From the top of the screen, select the “Process” tab (Figure A28): 

 

NOTE: 

The next two steps (3A and 3B) require the spectrum to be in Absorbance mode. 

 

 

Figure 28. “Process” tab options. 

 

A. The choose “Automatic Smooth”, click on the original spectrum (should turn red) 

and hide it, View → Hide Spectra. 

A 

C 

B 
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NOTE: 

The original spectrum will appear as a different color while the new spectrum will be red. In 

the upper right hand corner, there will be two names, one will have a different number of “*” to 

indicate how far off of the initial spectrum it is (Figure A28). This will happen for both the 

Automatic Smooth and Baseline Correct Processing steps (Figure A29). 

 

Figure A29. Original and Smoothed Spectra. 

 

B. Choose “Automatic Baseline Correct”, hide the spectrum with only one “*” (see 

note under point ‘A’ in this section). 

C. In the “Process” tab, select “% Transmittance” (The “Absorption” option just above 

this will switch it back if needed). 

4. Under the “Analyze” tab select “Find Peaks” (Figure A30). 

 

Name of each 

spectrum 

New spectrum (name 

will have an “*”) 

Original spectrum 
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Figure A30. “Analyze” Tab Options. 

 

5. Selecting along the baseline for the spectrum will move the horizontal line to the top of the 

graph. This will include the most amount of peaks that will be used for analysis. (Figure A31, 

Figure A32). 

 

NOTE: 

If the spectrum has a lot of “noise” the top of the graph may include too many peaks. For 

a noisy spectrum, a middle area may be a better choice to place the peak line.  

 

 

 

 

 

Step 4 

Step 8A 

Step 11 



 

57 

 

 

 

Figure A31. Initial horizontal line position when Automatic peak finding is opened. 

 

 

Figure A32. Find Peak line moved to include all peaks. 

 

Move this line by clicking the spectrum 

at the highest point 

 

Clicking here will 

move the horizontal 

bar to include all 

peaks 
Adds peaks to 

the spectrum 



 

58 

 

6. Return to the main screen with the peaks identified by selecting the “Replace” button. 

7. The second option for identifying peaks is to do it manually. 

 

 

 

 

Manual Peak Identification 

1. Find the  at the bottom left of the screen and select it. 

2. Go to any peak to be  identified. 

3. Click, hold, and drag down on the peak. A box will appear with the wavenumber (Figure  

A33). 

 

Figure A33. Adding a peak manually. 

4. Hit enter. 

5. Switch back to the standard cursor, , in the bottom left of the screen. 
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8. After reviewing the results, the search result window can be closed by selecting the “Close” 

button in the bottom right corner (Figure A34). 

 

 

Figure A34. Library search result page. 

 

 

9. Choose “IR Spectrum Interpretation” to display the groups that are present (Figure A35): 

1. Analyze → IR Spectrum Interpretation (Figure A30). 
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Figure A35. Results of present groups. 

 

 

10.    Print as a PDF by clicking on the print icon in the top horizontal bar. 
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Saving a PDF Document 

1. Print as a PDF by clicking on the print icon in the top horizontal bar. 

2. Choose “Printer Setup…” and then the PDF option from the printer drop down menu 

(Figure A36). 

 

Figure A36. Print screen. 

 

3. Hit “OK” and browse for the SITB file (Figure A37). 

i. Follow: Local Disk(C:) → My Documents → OMNIC →Spectra → SITB. 

 

Figure A37. Save PDF file window. 

 

4. Change the name so that it includes an indicator that describes the purpose of the file. 

Step 2 

Step 3 
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5. Hit “OK” to return to the “Save PDF file” window, and then hit “OK” again: 

i. If the “Open PDF in reader” box is selected, the PDF will appear in Acrobat. 

 

11. Rotate the blue knob until the tip is no longer on the crystal. 

12. Clean the crystal and the metal surface using Anticon wipes and IPA. This may 

have to be done more than once depending on the contamination present in the 

sample. 

13. When completely finished, return the Smart iTR and ZnSe crystal to Solutions 

Properties Laboratory (room 266). Place the second Smart iTR with the diamond 

crystal in the spectrometer and log out of the computer. 

NOTE: 

When completed with all samples, log your usage in the log book at the computer. This 

requires date, name, number of samples, and “Main”. 

 

 

14. Close the IR Spectrum Interpretation screen by clicking on the “Close” button in 

the lower right corner. 

15. Save the spectrum as a *.SPA file so that it could be analyzed later. 

A. Go to: File → Save As. 

i. The Save As screen will appear, check to make sure the “SITB” file is selected 

(“Error! Reference source not found.” will appear if incorrect file is selected). 

B. Select “Set File Name to Title” (Labeled as “B” in Figure A38). 
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16.  Remove the “@@” from the title, and save. 

 

Figure A38. “Save As” Screen for *.SPA files. 

 

 

Appendix A.1 

 

 

Setting Up a Method: 

 

 

 

 

NOTE: 

This section (Appendix A.1) is only needed if another method of collection is required. The 

“SITB NVR Analysis” has been setup for use for scavenger plate and cold finger analysis. 

Any of the settings can be changed. The following are the settings chosen for the SITB 

contamination evaluations. 

B 
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1. Select “Expt Set” from the bar across the top of the screen (Figure A39). 

 

 

Figure A39. Startup screen for OMNIC. 

 

2. Settings under “Collection” Tab (Figure A40): 

 

 

Expt Set Option 
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Figure A40. Settings under the Collect Tab in Experimental Setup. 

 

A. The Number of scans needs to be at least 8. 

B. Resolution is good at 4. 

C. Final format is %Reflectance (ATR uses reflectance when collecting). 

D. Automatic Atmosphere Suppression will take the environment into account 

during collection (H20 and CO2). 

E. The Preview Data Collection allows for a preview before collection begins. 

F. User does not want to save automatically, but wanta to save interferograms. 

G. Assign am Experiment title. This title is what will appear in the drop down menu 

in the top left of the main screen. 

H. Give an Experiment description. 

 

A 
B 

C 

D 

E 

F 

G 
H 
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3. Advanced Tab match setting for “SITB NVR Analysis” method (Figure A41).  

 

 

Figure A41. Advanced setting tab options. 

 

4. “Bench” tab setup: 

 

 

Figure A42. Settings for the Bench tab in Experimental Setup. 

A 

B 

C 

D 

E 
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A. For the FTIR Spectrometer set to “MAIN”, the microscope is “SCOPE”. 

B. The detector should be MCT/A. 

C. The Window can be changed between “Diamond” and “ZnSe” depending on which 

crystal is being used. 

D. Auto Gain allows for the readings to stay within a range. If it is not selected, there 

could be a peak that exceeds 100%. 

E. Velocity and Aperture are set to company recommended settings. 

 

5.  “Diagnostic” Tab (Figure A43): 

 

 

Figure A43. Setting screen for Diagnostic screen. 

 

B A 
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a. This can also be opened before filling the FTIR Spectrometer with LN2. The 

interferogram will increase in intensity as the detector is chilled.  

b. The procedures only need to be done if the spectrometer has been powered off: 

A. Reset Bench, if interferogram is not displayed. 

B. Align. 

6. Selecting save will add the method to the Experiment list:  

Library Search 

 

NOTE:  

This is to be done after peak identification. 

 

1. Check the Library Setup (Figure A44): 

A. Analysis → Library Setup (Figure A44). 

B. Check for the following libraries in the “Search libraries and groups” window (right 

side of the screen): 

i. Aldrich Condensed Phase Sample Library. 

ii. Georgia State Crime Lab Sample Library. 

iii. Hummel Polymer Sample Library. 

iv. Sigma Biological Sample Library. 

C. Libraries can be added by selecting the library in the left window and using the 

“Add >>” button to move them to the right. 

D. Click on the “Search Results” tab across the top (Figure A45). 

E. Change the number of spectra to be displayed to match the minimum number of 

compounds in list. 
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Figure A44. Library Setup with libraries added. 

 

 

 

Figure A45. Change the number of search spectra to be displayed. 

Number 1E 
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2. Selecting “Search” will return the compounds that have the closest match to the spectra that is 

being evaluated (Figure A45). 

3. Save the search as a PDF for future reference (See the section about Saving a PDF). 

4. After reviewing the results the search result window can be closed by selecting the “Close” 

button in the bottom right corner (Figure A46). 

 

Figure A46. Library search result page 
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APPENDIX B: GCMS SOFTWARE OVERVIEW 

 

 

 

 

GCMS Software Overview 
 

Kenneth W. Smith Jr., LARSS Intern 
 

 

 

April 26, 2013 
 

757.864.4651 
 

Kenneth.W.Smith@nasa.
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Objectives 


 The objective of this presentation is to help assist any  

persons who will be using the GCMS (Gas  

chromatography–mass spectrometry). 

 

 This presentation will include going through the software and  

the steps its takes to successfully operate the GCMS. 

 

 The set-up and preparation of the samples will be given in    

     another presentation by Patricia Davis and Keith Gordon. 

 

 A special thanks to Matt Shacka  from Goddard Space Flight  

Center for his expertise and training. 

 

And a big thank you to Denisse Aranda for making all of this  

     possible.

mailto:matthew.e.shacka@nasa.gov
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Step 1 



 From Desktop “Open GCMS Real Time Analysis.
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                                                 Step 2 
  

 Press OK (you will then hear a beep). 
 

 Press OK again. 
 

 NOTE: Will now see the previous batch appear. 
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                                            Process of 

 

 

 
    TUNING GCMS 
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Tuning 
 Before getting started, one must tune the instrument. 

 

 To get started tuning, Click “Top” on the side bar as shown. 
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Tuning 
 

 Click “Tuning” on the side bar. 
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Tuning 
 

 Click “Start Tuning” on the sidebar on left side of screen. 
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Tuning 
 

 The following window will now appear. 
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Tuning 

 

 When complete, the following window will appear  

      with two Tabs. Peak Profile and Spectrum. 
 

 Select Spectrum. 
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Tuning 
 

 

 If all is well one will see a similar spectrum: 

    •  Make sure 69 is base peak (Biggest). 

    •  18 and 28 should be considerably smaller. 
 

 

 

 

 

 

 

 

 

BASE PEAK 
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Tuning 
  

 Please print the Tuning files. 
 

 Write the date on them, then file them away. 
 

 Make sure to SAVE the Tuning file; it will be used later!!! 
 

 FileSave as use the following format: 
 

 EI_DATE Example EI_042413.qgr: 

    • 04 (April) 24 (day) and 13 (2013) 
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Step 3  
 

 After you save your tuning file, you will see the  

following tabs at the bottom of the screen. 
 

 Now click “Batch Table” to return to the initial 

screen. 
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Understanding the 
 

 

 

 

 

BATCH TABLE 
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Overview Look 
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Overview  



  Vial# - is the Vial the GCMS will call upon for the sample. 
 

  Sample Name  and Sample ID are just ID Tags for ease of use. 
 

  Sample Type - Please keep as 0:Unknown. 
 

  Analysis Type - Keep Blank. 

   •  IF ITQT Selected, go in the dropdown and unselect IT and 

                    QT. 
 

  Method file - Choose your method: 

   • NVRHT1.qgm (use when sample weight is above .34 mg) 

    • NVRHT1t.qgm (use when sample is under .34 mg) “more sensitive readings” 

   •  Bakeout.qgm (for short bakeouts) 

   •  Bakeoutlong.qgm (for long more thorough bakeouts) 
 

   Data File 

   •  Make a data file that best fits, Template: put date, project  name, and what                  

         the contaminants came off of.  

         (like 0424_SAGEIII_8x15TVACScavengerPlate.qgd). 
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Overview 
 

  Level # and Inj. Volume - Keep both at 1. 
 

  ISTD Amt. - Keep at Level 1 Con. 
 

  Report Output - Keep unchecked. 
 

  Report File - Change when new report is needed.  
 

  Tuning File - This is where you open up the file that  

was saved when tuning. 
 

  Data Description -  Keep blank. 
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Step 4 
  

 

 Go to FileSave batch file as Who its for_whats it  

from_date. 
 

 NOW HIT START! 
 
 
 
 
 
 
 
 

 

 This process will last anywhere from 90 minutesMultiple  

hours: 

• Depends on how many samples! 
 

 Readings will not start until 3 minutes into the process so  

don’t be alarmed when you see nothing at the beginning. 
.
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                                    General Post-Run  
 

 

 

 

 

ANALYSIS 
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                                                   Step 1 
 

 

 Open “GCMS Postrun Analysis” from desktop. 
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Step 2 
  

 

 Drop down bar FileOpen Choose sample  

need to open from the drop down bar. 
 

 OR use Data Explorer and Navigate and find the 

sample wanting to analyze (SEE BELOW): 
 

 Count the amount of peaks you see: 

• One could click then drag to zoom in to see   

   peaks better. 
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Step 3 
 

 

 From dropdown, go to qualitativePeak integrate

TIC… 
 

 Now check “Auto(area)” and put in number of peaks 

     you had seen (possibly a few extra for better analysis). 
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Step 4 
 

 Please go back and see if the peaks you want are  

selected: 

    • If there is an oversaturation and the machine shuts off.  This  

                      causes lack of recognition of a significant peak. 
 

 Troubleshoot: 

   •  If there was an oversaturation 3 times in one run, the run will stop!           

                  This means after a point all one will see is a flat line. Please look     

                   below, one will see this line after each saturation, but only for a    

                   short period unless it is the third saturation point in that run. 

•  When this happens the sample will now have to be diluted with   

     chloroform.  See set-up procedure for dilution instructions. 
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Step 5 
 

 If this saturated peak, or any peak you want  

included, is not selected, one may add peaks  

manually. 
 

 Go to QualitativeManual PeaksTIC 

 •  After zoomed by the peak you  want, just: 

  click to start. 

  drag to the end of the peak (now the peak is manually  

    Identified.) 

o Note this does not delete a peak, it is just an addition  

              of a peak. 
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Step 6 
 

  

 After identification a qualitative table must be  

      brought up for identification of peaks. 
 

 Go to the dropdown menu  QualitativeShow  

Qualitative Table.  
 

 A table will now appear with area percentage etc. 
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Step 7 
 

   

 To identify, click the name box for the corresponding  

peak. 
 

 The peak will appear on the graph and give you the  

spectrum. 
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Step 8 
 

  

 Find the base Peak, AKA biggest, as one did  

in the tuning section. 
 

 Look up the base peak in the Goddard reference 

handout (it is listed in ascending order of base 

peaks): 
 

• Ex., there is a 117 base peak! 

• Flip to the page where 117 is the first number (there is  

   only one) 

• Since there is only one, one can infer that it is “Solvent” 

•  HOWEVER if there are multiple, look at other peaks and 
try to find them on your Spectrum. Please have 2-3 
matches in spectrum before considering the material 
categorization. 

• When found, put name, such as “Solvent” in the name  

   table… this is seen on the next slide. 
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Step 9 
 

 If an unidentifiable material. Use the similarity  

search as shown below. 

•  This will give you a list of possible materials. You can  

    compare spectrums and see what matches. 
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Rule of Thumb 
 

  

 By rule of thumb if the total amount of area  

  is less than 1% one may delete the peak   

  categorization. 
 

 HOWEVER if it is a silicone, one must keep this  

because all silicone percentages will be added  

at the end. 
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                                         Identifiable Peaks 
 

 

  

 117- Will be Solvent (every run will have these  

thanks to chloroform). 
 

 73, 147, 221, 355-  SILICONE’ S.  
 

 149-Phthalate: 

• For Phthalates base peak is 149, most defining factor  

     for the type of phthalate are the numbers bigger  

     than 149. 
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Examples 

 Chloroform Blank: 

• Notice minimal peaks. 

• Peaks refer to solvent. 
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Examples 
 

 Reference in Chloroform (made by Goddard): 

• Notice solvent peaks at beginning. 

• Other easily identifiable peaks. 
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Examples 
 

 SAGE III ISS QCM: 
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Examples 
 

 

 SAGE III SCAVENGER PLATE: 
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Examples 
 

 

 Comparison of SAGE III QCM data and SCAVENGER  

PLATE data:
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   Post Analysis 
 

 

 

 

 

  WRITE-UP 
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                                            Reports  

 Follow these steps after identification. 
 

 EditSelect al.l. 
 

 Edit Register to spectrum process table. 
 

 Then Close Out. 
 

 Go to report in left hand side task bar. 
 

 Go to data explorer drop down. 
 

 Go to reports. 
 

 General reports, drag and then drop in. 
 

 Print. 
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                                          For more information contact the              

                                          following person(s): 

Keith Gordon   

Patricia Davis  

Kenneth Smith  

 

For expert help on analysis etc. 

Matt Shacka  

 

Contamination Lead Engineer 

            Denisse Aranda   
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